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Useful network programs
There are several programs available to setup the network settings easily in a 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

 

• Before using the programs below, set the IP address first. 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

1 

SyncThru™ Web Service

The web server embedded on your network machine allows you to do the 
following tasks (see "Using SyncThru™ Web Service" on page 202).

• Check the supplies information and status.

• Customize machine settings.

• Set the email notification option. When you set this option, the machine 
status (toner cartridge shortage or machine error) will be sent to a certain 
person's email automatically.

• Configure the network parameters necessary for the machine to connect to 
various network environments.

2 

SyncThru™ Web Admin Service

Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of managing 
network devices and lets you remotely monitor and troubleshoot network 
machines from any site with corporate internet access. 

• Download this program from http://solution.samsungprinter.com.

3 

SetIP wired network setup

This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol.

• See "IPv4 configuration using SetIP (Windows)" on page 134.

• See "IPv4 configuration using SetIP (Macintosh)" on page 135.

• See "IPv4 configuration using SetIP (Linux)" on page 136.

 

• The machine that does not support the network port, it will not be able 
to use this feature (see "Rear view" on page 24).

• TCP/IPv6 is not supported by this program.
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Wired network setup
4 

Printing a network configuration report

You can print Network Configuration Report from the machine’s control panel 
that will show the current machine’s network settings. This will help you to set 
up a network.

• Press the  (Menu) button on the control panel and select Network > 

Network Conf. (Network Configuration).

Using this Network Configuration Report, you can find your machine’s MAC 
address and IP address.

For example:

• MAC Address: 00:15:99:41:A2:78

• IP Address: 169.254.192.192

5 

Setting IP address

 

• The machine that does not support the network interface, it will not be 
able to use this feature (see "Rear view" on page 24).

• TCP/IPv6 is not supported by this program.

 

First, you have to set up an IP address for network printing and managements. 
In most cases a new IP address will be automatically assigned by a DHCP 
(Dynamic Host Configuration Protocol) server located on the network.

IPv4 configuration using SetIP (Windows)

Before using the SetIP program, disable the computer firewall from Control 
Panel > Security Center > Windows Firewall.

1 Install this program from the supplied CD-ROM by double-click 
Application > SetIP > Setup.exe.

2 Follow the instructions in the installation window.

3 Connect your machine to the network with a network cable.

4 Turn on the machine.

5 From the Windows Start menu, select All Programs > Samsung 
Printers > SetIP > SetIP.
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6 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.

7 Enter the machine’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this information 
assigned by a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

8 Click Apply, and then click OK. The machine will automatically print the 
Network Configuration Report. Confirm that all the settings are 
correct.

IPv4 configuration using SetIP (Macintosh)

Before using the SetIP program, disable the computer firewall from System 
Preferences > Security > Firewall.

 

The following instructions may vary from your model.

 

1 Connect your machine to the network with a network cable.

2 Insert the Installation CD-ROM, and open the disk window, select 
MAC_Installer > MAC_Printer > SetIP > SetIPapplet.html.

3 Double-click the file and Safari will automatically open, then select 
Trust. The browser will open the SetIPapplet.html page that shows the 
printer’s name and IP address information. 

4 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.

5 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.
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Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

6 Select Apply, then OK, and OK again.

7 Quit Safari.

IPv4 configuration using SetIP (Linux)

Before using the SetIP program, disable the computer firewall from System 
Preferences or Administrator.

 

The following instructions may vary from your model or operating systems.

 

1 Open /opt/Samsung/mfp/share/utils/.

2 Double-click the SetIPApplet.html file. 

3 Click to open the TCP/IP configuration window. 

4 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 134) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

5 The machine will automatically print the Network Configuration 
Report. 
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Installing driver over the network
 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

• The machine that does not support the network interface, it will not be 
able to use this feature (see "Rear view" on page 24).

 

6 

Windows

1 Make sure that the machine is connected to the network and powered 
on. Also, your machine’s IP address should have been set (see "Setting IP 
address" on page 134).

 

If the “Found New Hardware Wizard” appears during the installation 
procedure, click Cancel to close the window.

 

2 Insert the supplied software CD into your CD-ROM drive.

3 Select Install Now.

 

The Custom Installation allows you to select the machine’s connection and 
choose individual components to install. Follow the instructions on the 
window.

 

4 Read License Agreement, and select I accept the terms of the License 
Agreement. Then, click Next.

The program searches for the machine.
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If your machine is not found on the network or locally, an error message 
appears. Select the option you want and click Next.

 

5 The searched machines will be shown on the screen. Select the one you 
wish to use and click OK.

 

If the driver searched only one machine, the confirmation window appears.

 

6 Follow the instructions in the installation window.

Silent installation Mode

Silent installation mode is an installation method that does not require any user 
intervention. Once you start the installation, the machine driver and software 
are automatically installed on you computer. You can start the silent installation 
by typing /s or /S in the command window.

Command-line Parameters

Following table shows commands that can be used in the command window.

 

Following command-line are effective and operated when command is 
used with /s or /S. But /h, /H or /? are exceptional commands that can be 
operated solely.

 

Command- line Definition Description

/s or

/S

Starts silent installation. Installs machine drivers 
without prompting any UIs 
or user intervention.

/p”<port name>” or

/P”<port name>”

Specifies printer port.

 

Network Port will 
be created by use 
of Standard TCP/IP 
Port monitor. For 
local port, this port 
must exist on 
system before 
being specified by 
command.

 

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port 
name.

For example:

•  /p”xxx.xxx.xxx.xxx” in 
where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. /
p”USB001”, /P”LPT1:”, /
p”hostname”
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/a”<dest_path>” or

/A”<dest_path>”

Specifies destination path 
for installation.

 

The destination 
path should be a 
fully qualified path.

 

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.

/i”<script 
filename>” or

/I”<script 
filename>”

Specifies customized 
install script file for custom 
operation.

 

The script filename 
should be a fully 
qualified filename.

 

Customized script file can be 
assigned for customized 
silent installation. This script 
file can be created or 
modified through provided 
installer customizing utility 
or by text editor.

 

This customized 
script file is prior 
than default installer 
setting in setup 
package but not 
prior than 
command-line 
parameters.

 

Command- line Definition Description

/n”<Printer name>” 
or

/N”<Printer name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you can 
add printer instances as your 
wishes.

/nd or

/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed 
machine driver will not be 
the default machine driver 
on your system if there are 
one or more printer drivers 
installed. If there is no 
installed machine driver on 
your system, then this 
option won’t be applied 
because Windows OS will set 
installed printer driver as a 
default machine driver.

/x or

/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional 
driver.

Command- line Definition Description
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7 

Macintosh

1 Make sure that the machine is connected to your network and powered 
on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Macintosh desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5  Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message which warns that all applications will close on your 
computer appears, click Continue.

9 Click Continue on the User Options Pane.

/up”<printer 
name>” or

/UP”<printer 
name>”

Removes only specified 
printer instance and not 
the driver files.

This command provides a 
way to remove only 
specified printer instance 
from your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from your 
system.

/d or

/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove 
all installed device drivers 
and application software 
from your system.

/v”<share name>” 
or

/V”<share name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

/o or 

/O

Opens Printers and Faxes 
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

/f”<log filename>” 
or

/F”<log filename>”

Specifies log filename.

The default log file is 
created in the system temp 
folder if not specified.

It will create a log file to a 
specified folder.

Command- line Definition Description

/h, /H or /? Shows Command-line Usage.

Command- line Definition Description
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If you have not set the IP address yet, click Set IP address and refer to "IPv4 
configuration using SetIP (Macintosh)" on page 135. If you want to set the 
wireless setting, refer to.

 

10 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click Continue 
Installation.

13 After the installation is finished, click Quit or Restart.

14 Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5-10.7, open the Applications folder > System 
Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5-10.7, click the “+” icon. A display window will pop 
up. 

16 For Mac OS X 10.4, click IP Printer.

• For Mac OS X 10.5-10.7, click IP.

17 Select HP Jetdirect - Socket in Protocol.

 

When printing a document containing many pages, printing performance 
may be enhanced by choosing Socket for Printer Type option.

 

18 Enter the machine’s IP address in the Address input field.

19 Enter the queue name in the Queue input field. If you cannot determine 
the queue name for your machine server, try using the default queue 
first.

20 For Mac OS X 10.4, if Auto Select does not work properly, select Samsung 
in Print Using and your machine name in Model. 

• For Mac OS X 10.5-10.7, if Auto Select does not work properly, choose 
Select Printer Software and your machine name in Print Using.

21 Click Add.

Your machine appears in the Printer List, and is set as the default 
machine.

 

To install the fax driver: 

a Open the Applications folder > Samsung > Fax Queue Creator.
b Your machine appears on the Printer List.
c Select machine to use and Click Create button.
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8 

Linux

You need to download Linux software packages from the Samsung website to 
install the printer software (http://www.samsung.com > find your product > 
Support or Downloads).

Install the Linux driver and add network printer

1 Make sure that the machine is connected to your network and powered 
on. Also, your machine’s IP address should have been set. 

2 Download the Unified Linux Driver package from the Samsung website.

3 Extract the Download file and open the new directory.

4 Double-click the cdroot folder > autorun icon.

5 The Samsung installer window opens. Click Next.

6 The add printer wizard window opens. Click Next.

7 Select network printer and click Search button.

8 The machine’s IP address and model name appears on list field.

9 Select your machine and click Next.

10 Input the printer description and Next.

11 After the machine is added, click Finish.

12 When installation is done, click Finish.

Add a network printer

1 Double-click the Unified Driver Configurator.

2 Click Add Printer.

3 The Add printer wizard window opens. Click Next.

4 Select Network printer and click the Search button.

5 The printer’s IP address and model name appears on list field.

6 Select your machine and click Next.

7 Enter the printer description and click Next.

8 After the machine is added, click Finish.
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9 

UNIX

 

• Make sure your machine supports the UNIX operating system before 
installing the UNIX printer driver (see "Operating System" on page 7).

• The commands are marked with ”, when typing the commands, do not 
type “.

• Some features and optional goods may not be available depending on 
model or country (see "Operating System" on page 7).

 

To use the UNIX printer driver, you have to install the UNIX printer driver 
package first, then setup the printer. You can download the UNIX printer driver 
package from the Samsung website ((http://www.samsung.com > find your 
product > Support or Downloads).

Installing the UNIX printer driver package

The installation procedure is common for all variants of UNIX OS mentioned.

1 From the Samsung website, download and unpack the UNIX Printer 
Driver package to your computer. 

2 Acquire root privileges.

“su -”

3 Copy the appropriate driver archive to the target UNIX computer.

 

See administration guide of your UNIX OS for details.

 

4 Unpack the UNIX printer driver package.

For example, on IBM AIX, use the following commands.

“gzip -d < enter the package name | tar xf -”

5 Go to the unpacked directory.

6 Run the install script.

“./install”

install is the installer script file which is used to install or uninstall the 
UNIX Printer Driver package.

Use “chmod 755 install” command to give the permission to the 
installer script.

7 Execute the “. /install –c” command to verify installation results.

8 Run “installprinter” from the command line. This will bring up the Add 
Printer Wizard window. Setup the printer in this window referring to 
the following procedures.
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On some UNIX OS, for example on Solaris 10, just added printers may not be 
enabled and/or may not accept jobs. In this case run the following two 
commands on the root terminal:

“accept <printer_name>”

“enable <printer_name>”

 

Uninstalling the printer driver package

 

The utility should be used to delete the printer installed in the system.

a Run “uninstallprinter” command from the terminal.
It will open the Uninstall Printer Wizard.
The installed printers are listed in the drop-down list.

b Select the printer to be deleted.
c Click Delete to delete the printer from the system.
d Execute the “. /install –d” command to uninstall the whole package.
e To verify removal results, execute the “. /install –c” command.

 

To re-install it, use the command “. /install” to reinstall the binaries.

Setting up the printer

To add the printer to your UNIX system, run ‘installprinter’ from the command 
line. This will bring up the Add Printer Wizard window. Setup the printer in this 
window according to the following steps:

1 Type the name of the printer.

2 Select the appropriate printer model from the model list.

3 Enter any description corresponding to the type of the printer in the 
Type field. This is optional.

4 Specify any printer description in the Description field. This is optional.

5 Specify the printer location in the Location field.

6 Type the IP address or DNS name of the printer in the Device textbox for 
network-connected printers. On IBM AIX with jetdirect Queue type, 
only the DNS name is possible-numeric IP address is not allowed.

7 Queue type shows the connection as lpd or jetdirect in the 
corresponding list box. Additionally, usb type is available on Sun Solaris 
OS.

8 Select Copies to set the number of copies.
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9 Check the Collate option to receive copies already sorted.

10 Check the Reverse Order option to receive copies in the reverse order.

11 Check the Make Default option to set this printer as default.

12 Click OK to add the printer.
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IPv6 configuration
 

IPv6 is supported properly only in Windows Vista or higher.

 

 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7 or "Menu 
overview" on page 33).

• If the IPv6 network seems to not be working, set all the network setting 
to the factory defaults and try again using Clear Setting.

 

In the IPv6 network environment, follow the next procedure to use the IPv6 
address.

10 

From the control panel

1 Connect your machine to the network with a network cable.

2 Turn on the machine.

3 Print a Network Configuration Report that will check IPv6 addresses 
(see "Printing a network configuration report" on page 134).

4 Select Start > Control Panel > Printers and Faxes.

5 Click Add a printer in the left pane of the Printers and Faxes windows.

6 Click Add a local printer in the Add Printer windows.

7 The Add Printer Wizard window appears. Follow the instructions in the 
window.

 

If the machine does not work in the network environment, activate IPv6. 
Refer to the next section followed by.

 

Activating IPv6

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > IPv6 Activate.

3 Select On and press OK.

4 Turn the machine off and turn it on again.

5 Reinstall your printer driver.
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Setting IPv6 addresses

The machine supports the following IPv6 addresses for network printing and 
managements.

• Link-local Address: Self-configured local IPv6 address (Address starts with 
FE80).

• Stateless Address: Automatically configured IPv6 address by a network 
router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)

If you have a DHCPv6 server on your network, you can set one of the following 
options for default dynamic host configuration.

1 Press the  (Menu) button on the control panel.

2 Press Network > TCP/IP (IPv6) > DHCPv6 Config.

3 Press OK to select the required value you want.

• DHCPv6 Addr.: Always use DHCPv6 regardless of router request.

• DHCPv6 Off: Never use DHCPv6 regardless of router request.

• Router: Use DHCPv6 only when requested by a router.

11 

From the SyncThru™ Web Service

 

For models that do not have the display screen on the control panel, you 
need to access SyncThru™ Web Service first using the IPv4 address and 
follow the below procedure to use IPv6.

 

1 Access a web browser, such as Internet Explorer, from Windows. Enter 
the machine IP address (http://xxx.xxx.xxx.xxx) in the address field and 
press the Enter key or click Go.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

3 When the SyncThru™ Web Service window opens, move the mouse 
cursor over the Settings of the top menu bar and then click Network 
Settings.

4 Click TCP/IPv6 on the left pane of the website.

5 Check the IPv6 Protocol check box to activate IPv6.
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6 Check the Manual Address check box. Then, the Address/Prefix text 
box is activated.

7 Enter the rest of the address (e.g.,:3FFE:10:88:194::AAAA. “A” is the 
hexadecimal 0 through 9, A through F).

8 Choose the DHCPv6 configuration.

9 Click the Apply button.

Using SyncThru™ Web Service

1 Start a web browser, such as Internet Explorer, that supports IPv6 
addressing as a URL.

2 Select one of the IPv6 addresses (Link-local Address, Stateless 
Address, Stateful Address, Manual Address) from Network 
Configuration Report (see "Printing a network configuration report" on 
page 134).

3 Enter the IPv6 addresses (e.g.,: http://[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.

 



1492.  Using a Network-Connected Machine

Samsung Mobile Print
 

SCX-465xN/4321NS/465xFN/465xHN/4521NS Series only.

 

12 

What is Samsung Mobile Print?

Samsung Mobile Print is a free application that enables users to print photos, 
documents, and web pages directly from your smartphone or tablet. Samsung 
Mobile Print is not only compatible with your Android, Windows and iOS smart 
phones but also with your iPod Touch and tablet PC. It connects your mobile 
device to a network connected Samsung printer or to a wireless printer through 
a Wi-Fi access point. Installing a new driver or configuring network settings isn’t 
necessary – just simply install the Samsung Mobile Print application, and it will 
automatically detect compatible Samsung printers. Besides printing photos, 
web pages, and PDFs, scanning is also supported. If you have Samsung 
multifunction printer, scan any document into a JPG, PDF, or PNG format for 
quick and easy viewing on your mobile device. 

13 

Downloading Samsung Mobile Print

To download Samsung Mobile Print, go to the application store (Samsung 
Apps, Android Market, App Store, Marketplace) on your mobile device, and just 
search for “Samsung Mobile Print.” You can also visit iTunes for Apple devices 
or Marketplace for Windows devices on your computer.

Samsung Mobile Print 1.02.04  or higher

14 

Supported Mobile OS 

• Android OS 2.1 or higher 

• iOS 4.0 or higher

• Windows Phone 7 or higher

15 

Supported devices

• iOS 4.0 or higher: iPod Touch, iPhone, iPad

• Android 2.1 or higher: Galxy S, Galaxy S2, Galaxy Tab, and Android mobile 
devices

• Windows Phone 7 or higher: Samsung Focus, Omnia7, and OmniaW, and 
Windows mobile devices



3. Useful Setting Menus
This chapter explains how to browse the current status of your machine, and the method of setting for advanced 
machine setup. 

• Before you begin reading a chapter 151
• Copy menu 152
• Fax menu 155
• System setup 158 
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Before you begin reading a chapter
This chapter explains all the features available for this series' models to help users  easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 33).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing  (Menu).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the  (Menu) on the control panel, this feature is not applicable (see "Control panel overview" on page 25).

• Some menu names may differ from your machine depending on its options or the models.
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Copy menu
1 

Copy feature

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

1 If your has machine for (copy) buttons on the control panel, Select 
(copy).

• Press  (Menu) > Copy Feature on the control panel.

Item Description

Original Size Sets the image size.

Reduce/Enlarge

Reduces or enlarges the size of a copied image (see 
"Reduced or enlarged copy" on page 58).

 

If the machine is set Eco mode, reduce and 
enlarge features are not available.

 

Darkness
Adjusts the brightness level to make a copy that is 
easier to read, when the original contains faint 
markings and dark images (see "Darkness" on page 57)

Original Type
Improves the copy quality by selecting the document 
type for the current copy job (see "Original" on page 58)

Item Description
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Layout

Adjusts the layout format such as ID copy, 2/4-up.

2-up or 4-up

Reduces the size of the original images and prints 2 or 4 
pages onto one sheet of paper. 

 

This copy feature is available only when you 
load originals into the document feeder.

 

ID copy

Your machine can print 2-sided originals on one sheet.

The machine prints one side of the original on the 
upper half of the paper and the other side on the 
lower half without reducing the size of the original. 
This feature is helpful for copying a small-sized item 
such as business card.

 

• The original must be placed on the scanner 
glass to use this feature.

• If the machine set to Eco mode, this feature 
is not available.

 

Item Description

1
2

1 2

3 4

Adjust Bkgd

Prints an image without its background. This copy 
feature removes the background color and can be 
helpful when copying an original containing color in 
the background, such as a newspaper or a catalog.

• Off: Does not use this feature.

• Auto: Optimizes the background.

• Enhance Lev.1~2: The higher the number is, the 
more vivid the background is.

• Erase Lev.1~4: The higher the number is, the lighter 
the background is.

Item Description
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2 

Copy Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

Press (copy) >  (Menu) > Copy Setup on the control panel.

Item Description

Change Default
The copy options can be set to those most frequently 
used. 
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Fax menu
3 

Fax Feature

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (fax) >  (Menu)> Fax Feature on the control panel.

Item Description

Darkness
Adjusts the brightness level to scan an original that is 
easier to read, when the original contains faint 
markings and dark images (see "Darkness" on page 65).

Resolution

The default document settings procedure good results 
when using typical text-based originals. However, if you 
send originals that are of poor quality, or contain 
photographs, you can adjust the resolution to produce 
a higher quality fax (see "Resolution" on page 65).

Original Size Sets the image size.

Multi Send

Sends a fax to multiple destinations (see "Sending a fax 
to multiple destinations" on page 63).

 

You cannot send a color fax using this feature. 

 

Delay Send

Sets your machine to send a fax at a later time when you 
will not be present (see "Delaying a fax transmission" on 
page 191).

 

You cannot send a color fax using this feature. 

 

Priority Send

Scans the original into memory and immediately 
transmits it when the current operation is finished. 
Priority transmission will interrupt a sending to multiple 
destinations between stations (example, when the 
transmission to station A ends, before transmission to 
station B begins) or between redial attempts (see 
"Sending a priority fax" on page 192).

Send Forward

Set to forward  received and sent faxes to other 
destinations. If you are out of office but have to receive 
the fax, this feature may be useful.

• See "Forwarding a sent fax to another destination" 
on page 192.

Item Description
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4 

Sending setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (fax) >  (Menu) > Fax Setup > Sending on the control panel.

Rcv. Forward

Forwards the received a fax. If you are out of office but 
have to receive the fax, this feature may be useful. 

• See "Forwarding a received fax" on page 193.

Secure Receive

Stores the received fax in memory without printing out. 
To print received documents, you need to enter the 
password. You can prevent your received faxes from 
being accessed by unauthorized people (see "Receiving 
in secure receiving mode" on page 196).

Add Page
Adds additional documents to a reserved delay fax job 
(see "Adding documents to a reserved fax" on page 
191).

Cancel Job
Cancels the delayed fax job which is saved in memory 
(see "Canceling a reserved fax job" on page 192).

Item Description

Item Description

Redial Times
Sets the number of redial attempts. If you enter 0, the 
machine will not redial.

Redial Term Sets the time interval before automatic redialling. 

Prefix Dial
Sets a prefix of up to five digits. This number dials 
before any automatic dial number is started. It is useful 
for accessing a PABX exchange.

ECM Mode
Sends faxes using error correction mode (ECM) to 
makes sure the faxes are sent smoothly without any 
error. It may take more time.

Fax Confirm

Sets the machine to print a report whether a fax 
transmission was successfully completed or not. If you 
select On-Error, the machine prints a report only when 
a transmission is not successful.

Image TCR
Prints a transmission report with a minimized image of 
the first page of the fax sent. 

Dial Mode
Sets the dialing mode to either tone or pulse. This 
setting may not be available depending on your 
country.
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5 

Receiving setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (fax) >  (Menu) > Fax Setup > Receiving on the control panel.

Item Description

Receive Mode Selects the default fax receiving mode.

Ring To Answer
Specifies the number of times the machine rings before 
answering an incoming call.

Stamp RCV Name
Automatically prints the page number, and the date 
and time of reception at the bottom of each page of a 
received fax.

Rcv Start Code

Initiates fax reception from an extension phone 
plugged into the EXT socket on the back of the 
machine. If you pick up the extension phone and hear 
fax tones, enter the code. It is preset to *9* at the 
factory.

Auto Reduction
Automatically reduces an incoming fax page to fit the 
size of the paper loaded in the machine.

Discard Size
Discards a specific length from the end of the received 
fax.

Junk Fax Setup
Blocks any unwanted faxes that you stored in the 
memory as junk fax numbers. This setting may not be 
available depending on your country.

DRPD Mode

 Enables a user to use a single telephone line to answer 
several different telephone numbers. You can set the 
machine to recognize different ring patterns for each 
number. This setting may not be available depending 
on your country (see "Receiving faxes using DRPD 
mode" on page 196).

Item Description
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6 

Machine setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (Menu) > System Setup > Machine Setup on the control panel.

Item Description

Machine ID
Sets the machine ID which will be printed at the top of 
each fax page that you send.

Fax Number
Sets the fax number which will be printed at the top of 
each fax page that you send.

Date & Time Sets the date and time.

Clock Mode
Selects the format for displaying time between 12 hr. and 
24 hr. 

Language
Sets the language of the text that appears on the control 
panel display.

Power Save

Sets how long the machine waits before going to power 
save mode.

When the machine does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

Auto Power Off When the machine does not receive action for a specific 
time, power turns off automatically.

System Timeout
Sets the time that the machine remembers previously 
used copy settings. After the timeout, the machine 
restores the default copy settings.

Wakeup Event

You can set the condition to wake up from power-save 
mode. Set the item on.

• Off:  When you press Power/Wakeup button, the 
machine wake up from the power save mode. 

• On: The machine wake up by doing one of the actions 
below. 

- Pressing any button including Power/Wakeup 
button.

- Inserting paper in the document feeder.

- Opening or Closing the paper tray.

Item Description
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Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper. 

• On: If a paper mismatch occurs, an error message will 
display. The machine waits for about 30 second, then 
automatically clear the message and continue 
printing.

Altitude Adj.
Optimize print quality according to the machine’s 
altitude.

Paper Substit.

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you set 
the paper size to Letter in the printer driver, the machine 
prints on A4 paper and vice versa.

Toner Save

Activating this mode extends the life of your toner 
cartridge and reduces your cost per page beyond what 
one would experience in the normal mode, but it reduces 
print quality.

Item Description

Eco Settings

Allows you to save print resources and enables eco-
friendly printing. 

• Default Mode: Select whether to turn the Eco mode 
on or off.

 

On force (On-Forced): Sets the Eco mode on with 
password. If a user wants to turn the Eco mode 
on/off, the user needs to enter the password.

 

• Select Template (Select Temp.): Selects the eco 
template set from the SyncThru™ Web Service.

Item Description
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7 

Paper setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (Menu) > System Setup > Paper Setup on the control panel.

8 

Sound / Volume

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (Menu) > System Setup > Sound/Volume on the control panel.

Item Description

Paper Size
Sets the paper size as A4, Letter, or other paper sizes, 
according to your requirements.

Paper Type Chooses the type of the paper for each tray.

Margin Sets the margins for the document.

Item Description

Key Sound Turns the key sound on or off. With this option set to on, 
a tone sounds each time a key is pressed.

Alarm Sound
Turns the alarm sound on or off. With this option set to 
on, an alarm tone sounds when an error occurs or fax 
communication ends.
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9 

Report

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (Menu) > System Setup > Report on the control panel.
Speaker

Turns on or off the sounds from the telephone line 
through the speaker, such as a dial tone or a fax tone. 
With this option set to Comm. which means the speaker 
is on until the remote machine answers.

 

You can adjust the volume level using On Hook 
Dial. You can adjust the speaker volume only 
when the telephone line is connected.

a Press (fax) on the control panel.
b Press On Hook Dial. A dial tone sounds from 

the speaker.
c Press the arrows until you hear the volume you 

want.
d Press On Hook Dial to save the change and 

return to ready mode.

 

Ringer
Adjusts the ringer volume. For the ringer volume, you can 
select off, low, middle, and high level.

Item Description

Item Description

Configuration
Prints a report on the machine's overall 
configuration.

Supplies Info. Prints supplies’ information page. 

Address Book 
Prints all of the email addresses currently stored 
in the machine’s memory.

Fax Confirm

Prints a transmission report including the fax 
number, the number of pages, the elapsed time 
of the job, the communication mode, and the 
communication results for fax job. You can set up 
your machine to automatically print a 
transmission confirmation report after each fax 
job.
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10 

Maintenance

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

To change the menu options:

• Press  (Menu) > System Setup > Maintenance on the control panel.

Fax Sent
Prints information on the faxes you have recently 
sent.

Fax Received
Prints information on the faxes you have recently 
received.

Scheduled Jobs
Prints the document list currently stored for 
delayed faxes along with the starting time and 
type of each operation.

JunkFax
Prints the fax numbers specified as junk fax 
numbers.

Network Conf. 
Prints information on your machine’s network 
connection and configuration.

Usage Counter
Prints a usage page. The usage page contains the 
total number of pages printed.

Fax Options Prints the information of a fax reports.

Item Description

Item Description

CLR Empty Msg.
When toner cartridge is empty, this option appears. You 
can clear the empty message.

Supplies Life
Shows the supply life indicators (see "Monitoring the 
supplies life" on page 76.)

TonerLow Alert
Customizes the level to alert toner low or toner empty 
(see "Setting the toner low alert" on page 77).

Serial Number
Shows the machine’s serial number. When you call for 
service or register as a user on the Samsung website, you 
can find this.
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Network setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 33).

 

•  Press  (Menu)> Network on the control panel,

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment.

 

There are lots of parameters to be set. If you are 
not sure, leave as is, or consult the network 
administrator.

 

TCP/IP (IPv6)
Selects this option to use the network environment 
through IPv6 (see "IPv6 configuration" on page 146).

Ethernet Speed Configure the network transmission speed.

Clear Setting
Reverts the network settings to the default values. 
(Reboot required.)

Network Conf.
This list shows information on your machine’s network 
connection and configuration.

Protocol Mgr.

You can sets whether to use Ethernet on or off.

You can sets whether to use SyncThru™ Web Service or 
not.

Option Description



4. Special Features
This chapter explains special copying, scanning, faxing, and printing features.

• Altitude adjustment 165
• Entering various characters 166
• Registering authorized users 167
• Printing features 168
• Scan features 182
• Fax features 189
 

• The procedures in this chapter are mainly based on Windows 7.

• It may be necessary to press OK to navigate to lower-level menus for some models.
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Altitude adjustment
Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

1 High 3
2 High 2
3 High 1
4 Normal

You can set the altitude value from Device Settings in Samsung Easy Printer 
Manager program.

• For Windows and Macintosh users, see "Device Settings" on page 212.

• For Linux users.

 

• If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 
202).

• You can also set the altitude in System Setup option on the machine’s 
display (see "Machine’s basic settings" on page 36).

 

0

4,000 m
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3,000 m
(9,842 ft) 

2,000 m
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1,000 m
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Entering various characters
As you perform various tasks, you may need to enter names and numbers. For 
example, when you set up your machine, you enter your name or your 
company’s name, and the fax number. When you store fax numbers or email 
addresses in memory, you may also enter the corresponding names.

1 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For example, to 
enter the letter O, press 6, labeled with MNO. Each time you press 6, the display 
shows a different letter, M, N, O, m, n, o and finally 6. To find the letter that you 
want to enter, see "Keypad letters and numbers" on page 166.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the left/right or up/down arrow 
button.

 

2 

Keypad letters and numbers

 

• Special character sets may differ from your machine depending on its 
options or the models.

• Some of the follow key values may not appear depending on the job you 
are doing.

 

Key Assigned numbers, letters, or characters

1 @ / . ’ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* * % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for network authentication.)

# # = | ? " : { } < > ;

(These symbols are available when you type for network authentication.)
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Registering authorized users
 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

If you have connected your machine to a network and set up the network 
parameters correctly, you can scan and send images over the network. To send 
a scanned image through email or via network server safely, you must register 
account information of authorized users to your local machine using SyncThru™ 
Web Service.

1 Access the SyncThru™ Web Service (see "Using SyncThru™ Web Service" 
on page 202).

2 Click Login on the upper right of the SyncThru™ Web Service website.

3 Type in the ID and Password then click Login. We recommend you to 
change the default password for security reasons. 

• ID: admin 

• Password: sec00000

4 Click Security > User Access Control > Authentication.

5 Select Local Authentication in the Authentication Method, and click 
Apply.

6 Click OK in the confirmation pop-up window.

7 Click User Profile > Add.

8 Enter User Name, Login ID, Password, Confirm Password, E-mail 
Address, and Fax Number.

 

You can easily add individual address if you check Yes for Add individual(s) 
after this group is created. 

 

9 Click Apply.
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Printing features
 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 51).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

3 

Changing the default print settings

1 Click the Windows Start menu. 

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a �, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 

 

4 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a �, you can select other printer drivers 
connected to the selected printer.
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5 

Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by models" on page 7.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• Install optional memory when an XPS job does not print because the 
printer is out of memory.

• For models that provide XPS driver on the software CD:

- You can install the XPS printer driver when you insert the software CD 
into your CD-ROM drive. When the installation window appears, 
select Advanced Installation > Custom Installation. You can select 
the XPS printer driver in the Select Software and Utilities to Install 
window.

• For models that provide XPS driver from the Samsung website, 
www.samsung.com > find your product> Support or downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 54).

 

 

Item Description

Multiple Pages per Side Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 

Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.
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Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see 
what paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or 
 mark).

 

• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page 
of the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

Item Description

8 9
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• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the machine. 
This option is available only when you use the PCL/XPS printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing. This option is not available when you 
use Double-sided Printing (Manual).

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease 
the document.

Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Item Description
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Watermark

(Creating a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Overlaya

This option is available only when you use the PCL/SPL printer driver (see "Software" on page 8).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a 
watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Item Description
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Overlaya

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Overlaya

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file you 

want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box. 

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

 

•  This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on page 
10).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory. 

- Normal: This mode prints without storing your document in the optional memory. 

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies 
later. 

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 

- Store: Select this setting to save a document in the mass storage device (HDD) without printing. 

- Store and Print: This mode is used when printing and storing document at the same time. 

- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer spools the document into 
the mass storage device (HDD) and then prints it from the mass storage device (HDD) queue, decreasing the computer’s work load.

- Print Schedule: Select this setting to print the document at a specified time.

• User ID: This option is used when you need to find a saved file using the control panel. 

• Job Name: This option is used when you need to find a saved file using the control panel. 

Job Encryption

Encrypts printing data first, and transmits it to the machine. This feature protects the printing information even though the data is snatched 
on a network.

 

Job Encryption feature is enabled only when the mass storage device (HDD) is installed. The mass storage device (HDD) is used to 
decrypt the printing data (see "Variety feature" on page 10).

 

a. This option is not available when you use XPS driver.

Item Description
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6 

Macintosh printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Macintosh, you need to check the printer driver settings 
in each application you use. Follow the steps below to print from a Macintosh:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 
10).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Macintosh application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 
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Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.
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Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open an application, and select Print from the File menu

2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your machine from the 
printer list and click Properties.

4 Change the print job properties using the following four tabs displayed 
at the top of the window.

• General: Changes the paper size, the paper type, and the 
orientation of the documents. It enables the duplex feature, adds 
start and end banners, and changes the number of pages per sheet.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Text: Specifies the page margins and set the text options, such as 
spacing or columns.

• Graphics: Sets image options that are used when printing image 
files, such as color options, image size, or image position.

• Advanced: Sets the print resolution, paper source, and destination.

5 Click Apply to apply the changes and close the Properties window.

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the status of your 
print job.

To abort the current job, click Cancel.

Printing files

You can print many different types of files on your machine using the standard 
CUPS, directly from the command line interface. The CUPS lpr utility allows you 
to do that, but the driver’s package replaces the standard lpr tool by a much 
more user-friendly LPR GUI program.

To print any document file:

1 Enter lpr <file_name> from the Linux shell command line and press 
Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2 In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3 Click OK to start printing.
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Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, 
you can change the various properties for your machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click Properties.

3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and name. The 
name entered in this tab displays on the printer list in Printers 
configuration.

• Connection: Allows you to view or select another port. If you change 
the machine port from USB to parallel or vice versa while in use, you 
must re-configure the machine port in this tab.

• Driver: Allows you to view or select another machine driver. By 
clicking Options, you can set the default device options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel the 
selected job and select the Show completed jobs check box to see 
previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add to Class 
to add your machine to a specific class or click Remove from Class 
to remove the machine from the selected class.

4 Click OK to apply the changes and close the Printer Properties window.
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Unix printing 

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Features by models" on 
page 7).

 

Proceeding the print job

After installing the printer, choose any of the image, text, PS or HPGL files to 
print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2 Select a printer that has been already added.

3 Select the printing options from the window such as Page Selection.

4 Select how many copies are needed in Number of Copies.
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To take advantage of the printer features provided by your printer driver, 
press Properties.

 

5 Press OK to start the print job.

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can select various 
print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” for Apply, 
and “C” for Cancel.

General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according 
to your requirements.

• Paper Type: Choose the type of the paper. Options available in the list box 
are Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By default, it is Auto 
Selection.

• Orientation: Select the direction in which information is printed on a page.

• Duplex: Print on both sides of paper to save paper.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Multiple pages: Print several pages on one side of the paper.

• Page Border: Choose any of the border styles (e.g., Single-line hairline, 
Double-line hairline)

Image tab

In this tab, you can change the brightness, resolution, or image position of your 
document.

Text tab

Set the character margin, line space, or the columns of the actual print output.

HPGL/2 tab

• Use only black pen: To print all graphics in black.

• Fit plot to page: Fit the entire graphic into a single page.
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Margins tab

• Use Margins: Set the margins for the document. By default, margins are not 
enabled. The user can change the margin settings by changing the values in 
the respective fields. Set by default, these values depend on the page size 
selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab

Select various options in the JCL and General frames to customize various 
settings. These options are specific to the printer and depend on the PPD file.
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Scan features
 

• For basic scanning features, refer to the Basic Guide (see "Basic scanning" 
on page 61).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, depending 
on your system and what you are scanning, you may not be able to scan 
at certain resolutions, especially using enhanced dpi.
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Basic scanning method

 

This feature may not be available depending on model or optional goods 
(see "Variety feature" on page 10).

 

You can scan the originals with your machine via an USB cable or the network. 
The following methodoloqies can be used for scanning your documents:

• Scan to PC: Scan the originals from the control panel. Then, the scanned 
data will be stored in the connected computers My Documents folder (see 
"Basic Scanning" on page 61).

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning an 
image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or the 
network connection (see "Scanning from image editing program" on page 
184).

• Samsung Scan Assistant/Samsung Easy Document Creator: You can use 
this program to scan images or documents.

- See "Scanning with Samsung Scan Assistant" on page 185.

- See "Using Samsung Easy Document Creator" on page 205.

• WIA: WIA stands for Windows Images Acquisition. To use this feature, your 
computer must be connected directly with the machine via an USB cable 
(see "Scanning using the WIA driver" on page 185).
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Setting the scan settings in the computer

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

1 Open Samsung Easy Printer Manager (see "Using Samsung Easy 
Printer Manager" on page 210).

2 Select the appropriate machine from the Printer List.

3 Select Scan to PC Settings menu.

4 Select the option you want.

• Scan Activation: Determines whether or not scanning is enabled on 
the device.

• Basic tab:  Contains settings related to general scan and device 
settings.

• Image tab:  Contains settings related to image altering.

5 Press Save > OK.
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Scanning from network connected machine

 

The machine that does not support the network interface, it will not be able 
to use this feature (see "Rear view" on page 24).

 

Make sure the printer driver is installed on your computer using the software CD, 
since the printer driver includes the scan program (see "Installing the driver 
locally" on page 30).

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

 

If you see Not Available message, check the port connection.

 

2 Select your registered computer ID, and enter the Password if 
necessary.
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• ID is the same ID as the registered scan ID for Samsung Easy Printer 

Manager > Switch to advanced mode > Scan to PC Settings.

• Password is the 4 digit number registered password for Samsung Easy 

Printer Manager > Switch to advanced mode > Scan to PC 

Settings.

 

3 Select the option you want and press OK.

4 Scanning begins.

 

Scanned image is saved in computer’s C:\Users\users name\My 
Documents. The saved folder may differ, depending on your operating 
system or the application you are using.
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Scanning from image editing program

You can scan and import documents at the image editing software such as 
Adobe Photoshop, if the software is TWAIN-compliant. Follow the steps below 
to scan with TWAIN-compliant software:

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

3 Open an application, such as Adobe Photoshop.

4 Click File > Import, and select the scanner device.

5 Set the scan options.

6 Scan and save your scanned image.
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Scanning using the WIA driver

Your machine supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by Microsoft 
Windows 7 and works with digital cameras and scanners. Unlike the TWAIN 
driver, the WIA driver allows you to scan and easily adjust images without using 
additional software:

 

The WIA driver works only on Windows OS (not supported Windows 2000) 
with a USB port.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

3 Click Start > Control Panel > Hardware and Sound > Devices and 
Printers.

4 Right-click on device driver icon in Printers and Faxes > Start Scan.

5 New Scan application appears.

6 Choose your scanning preferences and click Preview to see your 
preferences affect the picture.

7 Scan and save your scanned image.
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Scanning with Samsung Scan Assistant

You need to download Samsung Scan Assistant software from the Samsung 
website to install the printer software (http://www.samsung.com > find your 
product > Support or Downloads).

 

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• You can use the OCR (Optical Character Reader) feature from Samsung 
Scan Assistant program.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

3 Click Start > All programs > Samsung Printers, and start Samsung 
Scan Assistant. For Macintosh, Applications folder > Samsung folder > 
Scan Assistant.

 

Select the Help menu or click the  button from the window and click on 
any option you want to know about. 
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4 Set the scan options.

5 Click Scan.
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Macintosh scanning

Scanning from USB connected machine

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

3 Start Applications and click Image Capture. 

 

If No Image Capture device connected message appears, disconnect the 
USB cable and reconnect it. If the problem continues, refer to the Image 
Capture’s help.

 

4 Select the option you want. 

5 Scan and save your scanned image.

 

If scanning does not operate in Image Capture, update Mac OS to the latest 
version. Image Capture operates properly in Mac OS X 10.4.7 or higher.

 

Scanning from network connected machine

 

Network model only (see "Features by models" on page 7).

 

1 Make sure that your machine is connected to a network.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

3 Start Applications and click Image Capture. 

4  According to OS, follow steps below. 

• For 10.4

- Click Devices > Browse Devices on Menu bar.

- Select your machine in Twain devices option. Make sure that Use 
TWAIN software checkbox is checked.
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-  Click Connect.

If a warning message appears, click Change Port.. to select port, 
or If TWAIN UI appears, click Change Port.. from the Preference 
tab and select a new port.

• For 10.5

- Click Devices > Browse Devices on Menu bar.

- Make sure that Connected checkbox is checked beside your 
machine in Bonjour Devices.

-  If you want to scan using TWAIN, refer to the Mac OS X10.4 steps 
above.

• For 10.6 -10.7, select your device below SHARED.

5 Set the scan options on this program.

6 Scan and save your scanned image.

 

• If scanning does not operate in Image Capture, update Mac OS to the 
latest version. Image Capture operates properly Mac OS X 10.4.7 or 
higher.

• For more information, refer to the Image Capture’s help.

• You can also scan using TWAIN-compliant software, such as Adobe 
Photoshop.
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Linux scanning

Scanning

1 Make sure that the machine is connected to your computer and 
powered on.

2 Double-click the Unified Driver Configurator on your desktop. 

3 Click the  button to switch to Scanners Configuration. 

4 Select the scanner on the list.
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5 Click Properties. 

6 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

7 From the Scanner Properties window, click Preview.

8 The document is scanned and the image preview appears in the 
Preview Pane.

9 Drag the pointer to set the image area to be scanned in the Preview 
Pane.

10 Select the option you want. 

11 Scan and save your scanned image.

 

For later use, you can save as your scan settings and add it to the Job Type 
drop-down list. 

 

Editing an image with Image Manager

The Image Manager application provides you with menu commands and tools 
to edit your scanned image.
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Fax features
 

• For basic faxing features, refer to the Basic Guide (see "Basic faxing" on 
page 62).

• This function is not supported for SCX-465x/465xN/4021S/4321NS (see 
"Control panel overview" on page 25).
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Automatic redialing

When the number you have dialed is busy or there is no answer when you send 
a fax, the machine automatically redials the number. The redial time depends on 
the country's factory default setting. 

 When the display shows Retry Redial?, press  (Start) button to redial the 

number without waiting. To cancel the automatic redialing, press  (Cancel or 
Stop/Clear). 

To change the time interval between redials and the number of redial attempts.

1 Press  (fax) >  (Menu)> Fax Setup > Sending on the control 
panel.

2 Select Redial Times or Redial Term you want.

3 Select the option you want.
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Redialing the fax number

1 Press  (Redial/Pause) button on the control panel. 

2 Select the fax number you want.

Ten recently sent fax numbers with ten received Caller IDs are shown.

3 When an original is loaded in the document feeder, the machine 
automatically begins to send.

If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK. When you have finished, 
select No when Another Page? appears.
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Confirming a transmission

When the last page of your original has been sent successfully, the machine 
beeps and returns to ready mode.

When something goes wrong while sending your fax, an error message appears 

on the display. If you receive an error message, press  (Cancel or Stop/Clear) 
to clear the message and try to send the fax again. 
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You can set your machine to print a confirmation report automatically each 

time sending a fax is completed. Press  (fax) >  (Menu) > Fax Setup 
> Sending > Send Report on the control panel.
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Sending a fax in the computer

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7). 

 

You can send a fax from your computer without going to the machine.

To send a fax from your computer, the Samsung Network PC Fax program 
must be installed. This program will be installed when you installed the printer 
driver. 

1 Open the document to be sent.

2 Select Print from the File menu. 

The Print window will be displayed. It may look slightly different 
depending on your application.

3 Select Samsung Network PC Fax from the Print window

4 Click Print or OK.

5 Enter the recipients’ numbers and select the option

 

Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

6 Click Send.
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Delaying a fax transmission

You can set your machine to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder.

2 Press  (fax) on the control panel.

3 Adjust the resolution and the darkness to suit your fax needs.

4 Press  (Menu) > Fax Feature > Delay Send on the control panel.

5 Enter the number of the receiving fax machine and press OK.

6 The display asks you to enter another fax number to send the document.

7 To enter more fax numbers, press OK when Yes highlights and repeat 
steps 5. 

 

• You can add up to 10 destinations.

• Once you entered a group dial number, you cannot enter another group 
dial numbers anymore.

 

8 Enter the job name and the time.

 

If you set a time earlier than the current time, the fax will be sent at that time 
on the following day.

 

9 The original is scanned into memory before transmission.

The machine returns to ready mode. The display reminds you that you 
are in ready mode and that a delayed fax is set.

 

You can check the list of delayed fax jobs.

Press  (Menu) > System Setup > Report > Schedule Jobs on the 
control panel.

 

Adding documents to a reserved fax

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder.

2 Press  (fax) >  (Menu) > Fax Feature > Add Page on the control 
panel.

3 Select the fax job and press OK.

When you have finished, select No when Another Page? appears. The 
machine scans the original into memory.

4 Press  (Cancel or Stop/Clear) to return to ready mode.
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Canceling a reserved fax job

1 Press  (fax) >  (Menu) > Fax Feature > Cancel Job on the control 
panel.

2 Select the fax job you want and press OK.

3 Press OK when Yes highlights.

The selected fax is deleted from memory.

4 Press  (Stop/Clear) to return to ready mode.
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Sending a priority fax

This function is used when a high priority fax need to be sent ahead of reserved 
operations. The original is scanned into memory and immediately transmitted 
when the current operation is finished.

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder.

2 Press  (Fax) >  (Menu) > Fax Feature > Priority Send on the 
control panel.

3 Enter the destination fax number and press OK.

4 Enter the job name and press OK.

5 If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.

When you have finished, select No when Another Page? appears.

The machine starts to scan and send a fax to destinations.
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Forwarding a sent fax to another destination

You can set the machine to forward the received or sent fax to other destination 
by a fax, an email or a server. If you are out of office but have to receive the fax, 
this feature may be useful.

 

• When you forward a fax by an email, you must first set the mail server and 
IP address in SyncThru™ Web Service (see "Using SyncThru™ Web 
Service" on page 202).

• Though you sent or received a color fax, the data is forwarded in 
grayscale.

 

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder.

2 Press  (fax) >  (Menu) > Fax Feature > Forward > Fax > Send 
Forward > On on the control panel.
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Forward options may not be available depending on model or optional 
goods (see "Variety feature" on page 10).

 

3 Enter the destination fax number, email address, or server address and 
press OK.

4 Press  (Cancel or Stop/Clear) to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.
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Forwarding a received fax

You can set the machine to forward the received or sent fax to other destination 
by a fax, an email or a server. If you are out of office but have to receive the fax, 
this feature may be useful.

 

Though you sent or received a color fax, the data is forwarded in grayscale.

 

1 Press  (fax) >  (Menu) > Fax Feature > Forward > Fax, E-mail, or 
Server > Receive Forward or RCV Forward > Forward on the control 
panel.

 

• Forward options may not be available depending on model or optional 
goods (see "Variety feature" on page 10).

• To set the machine to print out a fax when fax forwarding has been 
completed, select Forward&Print. 

 

2 Enter the destination fax number, email address, or server address and 
press OK.

3 Enter the starting tim and ending time, then press OK.

4 Press  (Cancel or Stop/Clear) to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.
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Receiving a fax in the computer

 

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• To use this feature, set the option on the control panel:

Press  (fax) >  (Menu) > Fax Feature > Forward > PC > On the 
control panel.
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1 Open the Samsung Easy Printer Manager.

2 Select the appropriate machine from the Printer List.

3 Select Fax to PC Settings menu.

4 Use Enable Fax Receiving from Device to change the fax settings.

• Image Type: Convert the received faxes to PDF or TIFF.

• Save Location: Select location to save the converted faxes.

• Prefix: Select prefix. 

• Print received fax: After receiving the fax, set prints information for 
the received fax.

• Notify me when complete:  Set to show the popup window to 
notify receiving a fax.

• Open with default application:  After receiving the fax, open it with 
default application.

• None:  After receiving a fax, the machine does not notify the user or 
opens the application.

5 Press Save > OK.
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Changing the receive modes

1 Press  (fax) >  (Menu) > Fax Setup > Receiving > Receive Mode 
on the control panel.

2 Select the option you want. 

• Fax: Answers an incoming fax call and immediately goes into the fax 
reception mode.

• Tel: Receives a fax by pressing (On Hook Dial) and then  

(Start) button.

• Ans/Fax: Is for when an answering machine attached to your 
machine. Your machine answers an incoming call, and the caller can 
leave a message on the answering machine. If the fax machine 
senses a fax tone on the line, the machine automatically switches to 
Fax mode to receive the fax.

 

To use the Ans/Fax mode, attach an answering machine to the EXT socket 
on the back of your machine. 

 

• DRPD: You can receive a call using the Distinctive Ring Pattern 
Detection (DRPD) feature. Distinctive Ring is a telephone company 
service which enables an user to use a single telephone line to 
answer several different telephone numbers. For further details, see 
"Receiving faxes using DRPD mode" on page 196.
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This setting may not be available depending on your country. 

 

3 Press OK.

4 Press  (Cancel or Stop/Clear) to return to ready mode.
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Receiving manually in Tel mode

You can receive a fax call by pressing  (On Hook Dial) button and then 

pressing  (Start) when you hear a fax tone. If your machine has a handset, 

you can answer calls using the handset (see "Features by models" on page 7).
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Receiving in Answering Machine/Fax mode

To use this mode, you must attach an answering machine to the EXT socket on 
the back of your machine. If the caller leaves a message, the answering machine 
stores the message. If your machine detects a fax tone on the line, it 
automatically starts to receive the fax.

 

• If you have set your machine to this mode and your answering machine 
is switched off, or no answering machine is connected to EXT socket, 
your machine automatically goes into Fax mode after a predefined 
number of rings.

• If the answering machine has a user-selectable ring counter, set the 
machine to answer incoming calls within 1 ring.

• If the machine is in Tel mode, disconnect or switch off the answering 
machine with the fax machine. Otherwise, the outgoing message from 
the answering machine will interrupt your phone conversation.
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Receiving faxes with an extension telephone

When you are using an extension telephone connected to the EXT socket, you 
can receive a fax from someone you are talking to on the extension telephone, 
without going to the fax machine.

When you receive a call on the extension phone and hear fax tones, press the 
keys *9* on the extension phone. The machine receives the fax.

*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
want.

 

While you are talking over the telephone connected to the EXT socket, copy 
and scan features are not available.

 



Fax features

1964.  Special Features

30 

Receiving faxes using DRPD mode

This setting may not be available depending on your country. Distinctive Ring is 
a telephone company service which enables an user to use a single telephone 
line to answer several different telephone numbers. This feature is often used by 
answering services who answer telephones for many different clients and need 
to know which number someone is calling in on to properly answer the phone.

 

This setting may not be available depending on your country. 

 

1 Select  (fax) >  (Menu) > Fax Setup > Receiving > DRPD Mode 
> Waiting Ring on the control panel. 

2 Call your fax number from another telephone. 

3 When your machine begins to ring, do not answer the call. The machine 
requires several rings to learn the pattern.

When the machine completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.

4 Press OK when DRPD appears and start over from step 2.

 

• DRPD must be set up again if you re-assign your fax number, or connect 
the machine to another telephone line.

• After DRPD has been set up, call your fax number again to verify that the 
machine answers with a fax tone. Then have a call placed to a different 
number assigned to that same line to be sure the call is forwarded to the 
extension telephone or answering machine plugged into the EXT socket.
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Receiving in secure receiving mode

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

You may need to prevent your received faxes from being accessed by 
unauthorized people. Turn on secure receiving mode, then all incoming faxes 
go into memory. You can print the incoming faxes with entering the password. 
 

To use the secure receiving mode, activate the menu from  (fax) >  
(Menu) > Fax Feature > Secure Receive on the control panel. 
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Printing received faxes

1 Select  (fax) >  (Menu) > Fax Feature > Secure Receive > Print 
on the control panel. 

2 Enter a four-digit password and press OK. 

3 The machine prints all of the faxes stored in memory.
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Receiving faxes in memory

Since your machine is a multi-tasking device, it can receive faxes while you are 
making copies or printing. If you receive a fax while you are copying or printing, 
your machine stores incoming faxes in its memory. Then, as soon as you finish 
copying or printing, the machine automatically prints the fax.

 

If fax is received and being printed, other copy and print jobs cannot be 
processed at the same time.
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Printing sent fax report automatically

 You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.

1 Press  (fax) >  (Menu) > Fax Setup > Auto Report > On on the 
control panel.

2 Press  (Cancel or Stop/Clear) to return to ready mode.



5. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 

• Easy Capture Manager 199
• Samsung AnyWeb Print 200
• Easy Eco Driver 201
• Using SyncThru™ Web Service 202
• Using Samsung Easy Document Creator 205
• Using Samsung Easy Printer Manager 210
• Using Samsung Printer Status 213
• Using the Linux Unified Driver Configurator 215
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Easy Capture Manager
 

• This feature may not be available depending on model or optional goods (see "Software" on page 8).

• Available for Windows OS users only (see "Software" on page 8).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key. Now you can easily print your captured screen as captured or edited.
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Samsung AnyWeb Print
 

• This feature may not be available depending on model or optional goods (see "Software" on page 8).

• Available for Windows and Macintosh OS users only (see "Software" on page 8).

 

This tool helps you screen-capture, preview, scrap, and print Windows Internet Explorer pages more easily, than when you use an ordinary program. Click Start > All 
programs > Samsung Printers > Samsung AnyWeb Print > Download the latest version to link to the website where the tool is available for download.
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Easy Eco Driver
 

• This feature may not be available depending on model or optional goods (see "Software" on page 8).

• Available for Windows OS users only (see "Software" on page 8).

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. To use this application, Start Easy Eco Driver before printing job 
checkbox in the printer properties should be checked. 

Easy Eco Driver also allows you simple editing such as removing images and texts, changing fonts, and more. You can save frequently used settings as a preset.

How to use: 

1 Open a document to print.

2 Print the document.

A preview window appears.

3 Select the options you want to apply to the document.

You can see the preview of the applied features.

4 Click Print.
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Using SyncThru™ Web Service
 

• Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only (see "Software" on page 8).

 

1 

Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to log-in as an 
administrator. You can still use SyncThru™ Web Service without logging in but 
you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service website.

2 Type in the ID and Password then click Login. We recommend you to 
change the default password for security reasons.

• ID: admin 

• Password: sec00000

2 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.

 

Information tab

This tab gives you general information about your machine. You can check 
things, such as remaining amount of toner. You can also print reports, such as an 
error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.
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• Usage Counters: Shows the usage count by print types: simplex and 
duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports, e-mail 
address, and font reports.

Settings tab

This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 
log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: Sets settings for IPv4/IPv6 filtering, and Authentication 
servers. 

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.

3 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.
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3 From the Security tab, select System Security > System Administrator

4 Enter the name of the administrator, phone number, location, and email 
address. 

5 Click Apply. 
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Using Samsung Easy Document Creator
Samsung Easy Document Creator is an application to help users scan, compile, 
and save documents in multiple formats, including .epub format. These 
documents can be shared via social networking sites or fax. Whether you’re a 
student needing to organize research from the library or a stay-at-home mom 
sharing scanned pictures from last year’s birthday party, Easy Document Creator 
will provide you with the necessary tools.

 

• Availabe for Windows OS users only.

• Windows XP or higher and Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Document Creator.

• Samsung Easy Document Creator is installed automatically when you 
install the machine software. 

 

4 

Understanding Samsung Easy Document Creator

To open the program: 

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Document Creator > Samsung Easy Document Creator.

The Samsung Easy Document Creator interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1

 

(Information)

Click the information button to see the program’s version 
information. 

 (Help) Click the help button to get the information of any option 
you want to use.
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2

Quick Scan Automatically scans with the settings provided in 
Configuration. You can pre-set the options such as image 
type, document size, resolution, or file type (see "Quick 
Scanning" on page 207).

3

Scan Provides more in-depth options for scanning documents 
on a one-by-one basis (see "Scanning" on page 207).

 

Text Converting will only be available after 
installing the optical character recognition (OCR) 
software proivided in a separate installation file.

 

• Image Scanning: Use for scanning single or mulitple 
pictures.

• Document Scanning: Use for scanning documents 
with text or text and images.

• Text Converting:  Use for scanning documents that 
need to be saved in an editable text format.

• Book Scanning:  Use for scanning books with the 
flatbed scanner.

• Favorites:  User-created favorites for frequently-used 
scan settings.

4

SNS Upload Provides an easy and quick way to upload files to a variety 
of social networking sites (SNS). Scan an image directly or 
select an existing image to upload to Facebook, Flickr, 
Picasa, Google Docs, or Twitter (see "Scanning to a Social 
Networking Site" on page 208).

 

SNS Upload will only be available after 
Microsoft®.NET Framework 3.5 Service Pack 1 has 
been installed (http://www.microsoft.com/
download/en/details.aspx?id=22) and Windows 
XP or higher and Internet Explorer 7.0 or higher are 
required

 

5
E-Book 
Conversion

Provides the ability to scan multiple documents in as one 
e-book or convert existing files into an e-book format 
(.epub file) (see "Converting to an E-Book" on page 208).

6

Send Fax Provides the ability to directly fax a document from Easy 
Document Creator if the Samsung Network PC Fax driver 
is installed (see "Sending a fax in the computer" on page 
190).

 

If the Samsung Network PC Fax driver is not 
installed, this will be grayed out.

 

7 Configuration Provides the options for a Common and Quick Scan.

8 Device Name Shows the scanning/faxing device ready to use.
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Click the Help ( ) button from the upper-right corner of the window and 
click on any option you want to know about. 

 

5 

Using features

Scanning

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

2 Click Scan from the home screen.

3 Select the type of scanning or a favorites then click Start.

4 Make adjustments to the image (Scan Settings and More Options).

5 Click Scan to scan a final image or Prescan to get another preview 
image.

6 Select to Save to Location, Send to E-mail, or Send to SNS.

7 Click on Save (Saving a Scan), Send ( E-mailing a Scan), or Share ( 
Uploading).

 

If there is room on the document glass, more than one item can be scanned 

at the same time. Use the   tool to make multiple selection areas.

 

Quick Scanning

Configuring Quick Scan

To set up the Quick Scan options:

1 Click Configuration from the home screen.

2 Click on Default to use the default settings, or select your own options.

3 Click Apply to save changes.

9

Search If you cannot see any device ready to use, click this button 
to find a device.

 

Click Search Now to automatically search for all 
devices to which you have access.

 



Using Samsung Easy Document Creator

2085.  Useful Management Tools

Using Quick Scan

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

2 Click Quick Scan from the home screen.

3 Select a save location for the scanned images.

4 Click Save to save the image.

 

Click Scan More to scan another image with the same settings.

 

Scanning to a Social Networking Site

Scan Directly

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

2 Click SNS Upload from the home screen.

3 Click Scan to SNS > Start.

4 Click Scan.

Upload Existing File

1 Click SNS Upload from the home screen.

2 Click Existing File to SNS > Start.

3 Select the site and click Add Image to find the file to upload.

4 Select a social networking site to send the image and click Next. 

5 Follow the instructions in each social networking site.

 

 If there are some problems on accessing or uploading to each SNS site due 
to a network environment issue, it's needed to check security limitations 
established in your network with network administrator. To guarantee 
correct functioning of SNS upload in Samsung Easy Document Creator, 
unrestricted network environment is needed for HTTPS communication.

 

Converting to an E-Book

Scan Directly

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

2 Click E-Book Conversion from the home screen.
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3 Click Scan to E-Book > Start.

4 Enter a name and author to be used as metatag information for the 
.epub file, a file name, and select a save location.

5 Click Save.

Convert Existing Files

1 Click E-Book Conversion from the home screen.

2 Click Existing File to E-Book > Start.

3 Click Add Image to find the file to convert.

4 Enter a name and author to be used as metatag information for the 
.epub file, a file name, and select a save location.

5 Click Save.

Sending a Fax

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 48).

2 Click Send Fax from the home screen.

3 Click add file and locate the file to fax.

4 Click Send Fax.

5 Enter the fax information (recipient’s number, cover page information, 
etc).

6 Click Send.

6 

Plug-ins

Easy Document Creator will also create new plug-ins for Microsoft PowerPoint, 
Word, and Excel. These new plug-ins will be in a new Easy Document Creator 
menu on the applications’ menu bars: Scan to Office, Send Fax, and E-Book.
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Using Samsung Easy Printer Manager 
 

• This feature may not be available depending on model or optional goods 
(see "Software" on page 8).

• Available for Windows and Macintosh OS users only (see "Software" on 
page 8).

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager combines 
device settings as well as printing environments, settings/actions and 
launching. All of these features provide a gateway to conveniently use your 
Samsung machine. Samsung Easy Printer Manager provides two different user 
interfaces for the user to choose from: the basic user interface and the advanced 
user interface. Switching between the two interfaces is easy: just click a button.

7 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Printer Manager > Samsung Easy Printer Manager.

For Macintosh,

Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer List displays printers installed on your 

computer and network printers added by network 
discovery (Windows only).
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Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the machine’s 
model name, IP address (or Port name), and machine 
status.

 

You can view the online User’s Guide.

 Troubleshooting button: This button opens the 
Troubleshooting Guide when an error occurs. 
You can directly open the necessary section in the 
user’s guide. 

 

3

Application 
information

Includes links for changing to the advanced settings 
(switching UI), refresh, preference setting, summary, help, 
and about.

 

The  button is used to change the user 
interface to the advanced settings user interface 
(see "Advanced settings user interface overview" 
on page 212).

 

4

Quick links Displays Quick links to machine specific functions. This 
section also includes links to applications in the advanced 
settings.

 

If you connect your machine to a network, the 
SyncThru™ Web Service icon is enabled.

 

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information will vary 
based on the machine selected. Some machines do not 
have this feature.

6
Order supplies Click on the Order button from the supply ordering 

window. You can order replacement toner cartridge(s) 
from online.
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8 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person responsible 
for managing the network and machines.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

Device Settings

You can configure various machine settings such as machine setup, paper, 
layout, emulation, network, and print information.

Scan to PC Settings

This menu includes settings to create or delete scan to PC profiles. 

• Scan Activation: Determines whether or not scanning is enabled on the 
device.

• Basic tab:  Contains settings related general scan and device settings.

• Image tab:  Contains settings related to image altering.

Fax to PC Settings

This menu includes settings related to the basic fax functionality of the selected 
device. 

• Disable: If Disable is On, incoming faxes will not be received on this device.

• Enable Fax Receiving from Device: Enables faxing on the device and allow 
more options to be set.

Alert Settings (Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be received.

• Email Alert: Provides options relating to receiving alerts via email.

• Alert History:  Provides a history of device and toner related alerts.

Job Accounting

Provides querying of quota information of the specified job accounting user. 
This quota information can be created and applied to devices by job accounting 
software such as SyncThru™ or CounThru™ admin software.
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Using Samsung Printer Status 
The Samsung Printer Status is a program that monitors and informs you of the 
machine status. 

 

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 100).

• Available for Windows OS users only (see "Software" on page 8).

 

9 

Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 
Printer Status. Samsung Printer Status is installed automatically when you install 
the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might occur in 
the future. For example, it might be in toner low status, 
which may lead to toner empty status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.

2 Option You can set printing job alert related settings. 
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3
Order Supplies You can order replacement toner cartridge(s) from 

online.

4

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting 
Guide when an error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

 

5 Close Close the window.
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Using the Linux Unified Driver Configurator
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified Driver 
Configurator (see "Installation for Linux" on page 130).

After the driver is installed on your Linux system, the Unified Driver Configurator 
icon will automatically be created on your desktop.

10 

Opening Unified Driver Configurator

1 Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2 Click each button on the left to switch to the corresponding 
configuration window.

1 Printer Configuration 
2 Port Configuration 
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 To use the on screen help, the Help or  button from the window.

 

3 After changing the configurations, click Exit to close the Unified Driver 
Configurator.

11 

Printers configuration

Printers configuration has the two tabs: Printers and Classes.

Printers tab

View the current system’s printer configuration by clicking on the machine icon 
button on the left side of the Unified Driver Configurator window.

1 Switches to Printers configuration.

2 Shows all of the installed machines.

3 Shows the status, model name, and URI of your machine.
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The printer control buttons are, as follows:

• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.

• Remove Printer: Removes the selected machine.

• Set as Default: Sets the current selected machine as a default machine.

• Stop/Start: Stops/starts the machine.

• Test: Allows you to print a test page to ensure the machine is working 
properly.

• Properties: Allows you to view and change the printer’s properties. 

Classes tab

The Classes tab shows a list of available machine classes.

• Refresh: Renews the classes list.

• Add Class: Allows you to add a new machine class.

• Remove Class: Removes the selected machine class.

1 Shows all of the machine classes.

2 Shows the status of the class and the number of machines in the class.
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12 

Ports configuration

In this window, you can view the list of available ports, check the status of each 
port and release a port that is stalled in a busy state when its owner has 
terminated the job for any reason. • Refresh: Renews the available ports list.

• Release port: Releases the selected port.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3 Shows the port type, device connected to the port, and status.
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This chapter gives helpful information for what to do if you encounter an error.
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• Power and cable connecting problems 221
• Printing problems 222
• Printing quality problems 226
• Copying problems 234
• Scanning problems 235
• Faxing problems 237
• Operating system problems 239
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Paper feeding problems

Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, use the 
manual feeding in tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Envelopes skew or fail to feed correctly. Ensure that the paper guides are against both sides of the envelopes.
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Power and cable connecting problems

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power/Wakeup) button on the control, 

press it. 

• Disconnect the machine’s cable and reconnect it.
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Printing problems

Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  (Power/

Wakeup) button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The cover is not closed. Close the cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 90).

• No paper is loaded. Load paper (see "Loading paper in the tray" on page 39).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 74).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 74).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 24).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.
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The machine does not 
print.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening printing preferences" on page 53). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 54).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening printing preferences" on 
page 53). See the printer driver help screen (see "Using help" on page 54).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening printing preferences" on 
page 53).

The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

Condition Possible cause Suggested solutions
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The wrong printer driver was selected. Check the application’s printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 72.

• See "Replacing the toner cartridge" on page 74.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Before printing, the 
machine emits vapor near 
the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

Condition Possible cause Suggested solutions
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The machine does not 
print special-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening printing preferences" on page 53).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thick (see "Opening printing preferences" on page 53).

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 74).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 78).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
78). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the rest of 
the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 53).
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Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 78).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 78).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick (see "Opening 
printing preferences" on page 53).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 78).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 78).

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions
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Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and 
install a new one (see "Replacing the toner cartridge" on page 74).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
78). If these steps do not correct the problem, contact a service representative.

Black or color background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 74).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 72).

Toner smear • Clean the inside of the machine (see "Cleaning the machine" on page 78).

• Check the paper type and quality.

• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 74).

Condition Suggested solutions
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Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see 
"Replacing the toner cartridge" on page 74).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams 
on the reverse side. Printing on seams can cause problems.

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening printing preferences" on page 53). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 72).

Toner particles are around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 53).

• Ensure the correct paper type is selected. 

Condition Suggested solutions
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Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested solutions
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Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 78).

Solid color or black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 74).

• The machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 78).

• Check the paper type and quality.

• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 74).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 74).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening printing preferences" on page 53).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (see 
"Altitude adjustment" on page 165).

Condition Suggested solutions
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Copying problems

Condition Suggested solutions

Copies are too light or too dark. Adjust the darkness in copy feature to lighten or darken the backgrounds of copies (see "Changing the settings for each copy" on page 
57).

Smears, lines, marks, or spots 
appear on copies.

• If the defects are on the original, adjust darkness in copy feature to lighten the background of your copies.

• If there are no defects on the original, clean the scan unit (see "Cleaning the scan unit" on page 81).

Copy image is skewed. • Ensure that the original is aligned with the registration guide.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 78).

Blank copies print out. Ensure that the original is face down on the scanner glass or face up in the document feeder.

If these steps do not correct the problem, contact a service representative.

Image rubs off the copy easily. • Replace the paper in the tray with paper from a new package.

• In high humidity areas, do not leave paper in the machine for extended periods of time.

Frequent copy paper jams 
occur.

• Fan the paper, then turn it over in the tray. Replace the paper in the tray with a fresh supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper type and weight (see "Print media specifications" on page 103).

• Check for copy paper or pieces of copy paper remaining in the machine after a paper jam has been cleared.

Toner cartridge produces fewer 
copies than expected before 
running out of toner.

• Your originals may contain pictures, solids, or heavy lines. For example, your originals may be forms, newsletters, books, or other 
documents that use more toner.

• The scanner lid may be left open while copies are being made.

• Turn the machine off and back on.
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Scanning problems

Condition Suggested solutions

The scanner does not work. • Make sure that you place the original to be scanned face down on the scanner glass, or face up in the document feeder (see 
"Loading originals" on page 48).

• There may not be enough available memory to hold the document you want to scan. Try the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine printer cable is connected properly.

• Make sure that the machine printer cable is not defective. Switch the printer cable with a known good cable. If necessary, replace 
the printer cable.

• Check that the scanner is configured correctly. Check scan setting in the SmarThru Office or the application you want to use to make 
certain that the scanner job is being sent to the correct port (for example, USB001).

The unit scans very slowly. • Check if the machine is printing received data. If so, scan the document after the received data has been printed.

• Graphics are scanned more slowly than text.

• Communication speed slows in scan mode because of the large amount of memory required to analyze and reproduce the scanned 
image. Set your computer to the ECP printer mode through BIOS setting. It will help to increase the speed. For details about how 
to set BIOS, refer to your computer user’s guide.



Scanning problems

2366.  Troubleshooting

Message appears on your 
computer screen:

• Device can’t be set to the H/W 
mode you want.

• Port is being used by another 
program.

• Port is disabled.

• Scanner is busy receiving or 
printing data. When the 
current job is completed, try 
again.

• Invalid handle.

• Scanning has failed.

• There may be a copying or printing job in progress. Try your job again when that job is finished.

• The selected port is currently being used. Restart your computer and try again.

• The machine printer cable may be improperly connected or the power may be off.

• The scanner driver is not installed or the operating environment is not set up properly.

• Ensure that the machine is properly connected and the power is on, then restart your computer.

• The USB cable may be improperly connected or the power may be off.

Condition Suggested solutions
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Faxing problems

Condition Suggested solutions

The machine is not working, 
there is no display, or the 
buttons are not working.

• Unplug the power cord and plug it in again.

• Ensure that there is power being supplied to the electrical outlet.

• Ensure that the power is turned on.

No dial tone. • Check that the phone line is properly connected (see "Rear view" on page 24).

• Check that the phone socket on the wall is working by plugging in another phone.

The numbers stored in memory 
do not dial correctly.

Make sure that the numbers are stored in memory correctly. To check that, print an address book list.

The original does not feed into 
the machine.

• Make sure that the paper is not wrinkled and you are inserting it in correctly. Check that the original is the right size, not too thick 
or thin.

• Make sure that the document feeder is firmly closed.

• The document feeder rubber pad may need to be replaced. Contact a service representative (see "Available maintenance parts" on 
page 69).

Faxes are not received 
automatically.

• The receiving mode should be set to fax (see "Changing the receive modes" on page 194).

• Make sure that there is paper in the tray (see "Print media specifications" on page 103).

• Check to see if the display shows any error message. If it does, clear the problem.

The machine does not send. • Make sure that the original is loaded in the document feeder or on the scanner glass.

• Check the fax machine you are sending to, to see if it can receive your fax.

The incoming fax has blank 
spaces or is of poor-quality.

• The fax machine sending you the fax may be faulty.

• A noisy phone line can cause line errors.

• Check your machine by making a copy.

• A toner cartridge has almost reached its estimated cartridge life. Replace the toner cartridge (see "Replacing the toner cartridge" 
on page 74).
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Some of the words on an 
incoming fax are stretched.

The fax machine sending the fax had a temporary document jam. 

There are lines on the originals 
you sent.

Check your scan unit for marks and clean it (see "Cleaning the scan unit" on page 81).

The machine dials a number, 
but the connection with the 
other fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the other machine operator and 
ask them to solve the problem on their side.

Faxes do not store in memory. There may not be enough memory space to store the fax. If the display indicating the memory status shows, delete any faxes you no 
longer need from the memory, and then try to store the fax again. Call for service.

Blank areas appear at the 
bottom of each page or on 
other pages, with a small strip 
of text at the top.

You may have chosen the wrong paper settings in the user option setting. Check the paper size and type again.

Condition Suggested solutions
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Operating system problems
1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.
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2 

Common Macintosh problems

 

 

 

Refer to the Macintosh User’s Guide that came with your computer for further information on Macintosh error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Macintosh 
with Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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3 

Common Linux problems

 

Condition Suggested solutions

The machine does not print. • Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the Printers tab in the Printers 
configuration window to look at the list of available machines. Make sure that your machine is displayed on the list. If not, open 
Add new printer wizard to set up your device.

• Check if the machine is started. Open Printers configuration and select your machine from the printers list. Look at the description 
in the Selected printer pane. If its status contains Stopped, press the Start button. Normal operation of the machine should be 
restored. The “stopped” status might be activated when some problems in printing occur. 

• Check if your application has special print options such as “-oraw”. If “-oraw” is specified in the command line parameter, then 
remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit the command line parameter in the 
command item.

Some color images come out all 
black.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base color space of the document is indexed color 
space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you should 
upgrade Ghostscript on your system to at least GNU Ghostscript version 7.06 or later. You can find recent Ghostscript versions at 
www.ghostscript.com.

Some color images come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base color space of the document is indexed RGB 
color space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you should 
upgrade Ghostscript on your system to at least GNU Ghostscript version 8.xx or later. You can find recent Ghostscript versions at 
www.ghostscript.com.

The machine does not print 
whole pages, and output is 
printed on half the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in AFPL Ghostscript v. 8.52 or above. Download 
the latest version of AFPL Ghostscript from http://sourceforge.net/projects/ghostscript/ and install it to solve this problem.
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Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

I cannot scan via Gimp Front-
end.

Check if Gimp Front-end has Xsane:Device dialog. on the Acquire menu. If not, you should install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package for Gimp on Linux distribution CD or Gimp home page. For the detailed information, 
refer to the Help for Linux distribution CD or Gimp Front-end application. 

If you wish to use another kind of scan application, refer to application’s Help.

“Cannot open port device file” 
error message appears when 
printing a document.

Avoid changing print job parameters (e.q., via LPR GUI) while a print job is in progress. Known versions of CUPS server break the print 
job whenever print options are changed and then try to restart the job from the beginning. Since Unified Linux Driver locks the port 
while printing, the abrupt termination of the driver keeps the port locked and unavailable for subsequent print jobs. If this situation 
occurs, try to release the port by selecting Release port in the Port configuration window.

The machine does not appear 
on the scanners list.

• Ensure your machine is attached to your computer, connected properly via the USB port, and is turned on.

• Ensure the scanner driver for your machine is installed in your system. Open Unified Linux Driver configurator, switch to Scanners 
configuration, then press Drivers. Make sure that driver with a name corresponding to your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional components of machine (printer and scanner) share the same I/O interface (port), the 
situation of simultaneous access of different user applications to the same port is possible. To avoid possible conflicts, only one of 
them at a time is allowed to gain control over the device. The other user will encounter “device busy” response. This usually 
happens when starting a scan procedure. An appropriate message box appears.
To identify the source of the problem, open the Ports configuration and select the port assigned to your scanner, port's symbol /
dev/mfp0 corresponds to LP:0 designation displayed in the scanners’ options, /dev/mfp1 relates to LP:1, and so on. USB ports start 
at /dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 respectively and so forth sequentially. In the Selected port pane, you can 
see if the port is occupied by another application. If this is the case, you should either wait for completion of the current job or press 
the Release port button, if you are sure that the present port application is not functioning properly.

The machine does not scan. • Ensure a document is loaded into the machine, ensure your machine is connected to the computer.

• If there is an I/O error while scanning.

Condition Suggested solutions
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact 
the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIA 42 27 5755 www.samsung.com

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG 
(7267864, € 0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM 02-201-24-18 www.samsung.com/be 
(Dutch)

www.samsung.com/
be_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 05 133 1999 www.samsung.com

BRAZIL 0800-124-421

4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CAMEROON 7095-0077 www.samsung.com

CANADA 1-800-SAMSUNG (726-7864) www.samsung.com/ca

www.samsung.com/
ca_fr (French)

CHILE 800-SAMSUNG (726-7864)

From mobile 02-482 82 00

www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

COTE D’LVOIRE 8000 0077 www.samsung.com

CROATIA 062 SAMSUNG (062 726 7864) www.samsung.com

CYPRUS 8009 4000 only from landline www.samsung.com

CZECH REPUBLIC 800-SAMSUNG (800-726786) www.samsung.com

Samsung Electronics Czech and Slovak, s.r.o., Oasis Florenc, 
Sokolovská 394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 08000-726786 www.samsung.com

Country/Region Customer Care Center Web Site
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EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA 0800-10077

0302-200077

www.samsung.com

GREECE 80111-SAMSUNG (80111 726 
7864) only from land line

(+30) 210 6897691 from mobile 
and  land line

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG (852) 3698-4698 www.samsung.com/hk

www.samsung.com/
hk_en/

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

INDIA 1800 1100 11

3030 8282

1800 3000 8282

1800 266 8282

www.samsung.com

INDONESIA 0800-112-8888

021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com

ITALY 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 
(GSM:7799)

www.samsung.com

KENYA 0800 724 000 www.samsung.com

KOSOVO +381 0113216899 www.samsung.com

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

Country/Region Customer Care Center Web Site
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LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

MACEDONIA 023 207 777 www.samsung.com

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.com

MONGOLIA www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 0800-726-7864 www.samsung.com

NETHERLANDS 0900-SAMSUNG (0900-7267864) 
(€ 0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

Country/Region Customer Care Center Web Site

PHILIPPINES 1-800-10-SAMSUNG(726-7864) 
for PLDT

1-800-3-SAMSUNG(726-7864) for 
Digitel

1-800-8-SAMSUNG(726-7864) for 
Globe

02-5805777

www.samsung.com

POLAND 0 801-1 SAMSUNG (172-678)

+48 22 607-93-33

www.samsung.com

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

ROMANIA 08010 SAMSUNG (08010 726 
7864) only from landline

(+40) 21 206 01 10 from mobile 
and land line

www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SENEGAL 800-00-0077 www.samsung.com

SERBIA 0700 SAMSUNG (0700 726 7864) www.samsung.com

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site
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SLOVAKIA 0800-SAMSUNG 
(0800-726-7864)

www.samsung.com

SOUTH AFRICA 0860-SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

SWITZERLAND 0848-SAMSUNG 
(7267864, CHF 0.08/min)

www.samsung.com/ch

www.samsung.com/
ch_fr(French)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999

0266-026-066

www.samsung.com

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND 1800-29-3232

02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

UGANDA 0800-300 300 www.samsung.com

U.K 0330 SAMSUNG (7267864) www.samsung.com

Country/Region Customer Care Center Web Site

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

UKRAINE 0-800-502-000 www.samsung.com/ua

www.samsung.com/
ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site
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Glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) and is 
now deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.
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Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.

ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Macintosh (1984) and is now deprecated by Apple 
in favor of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).
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Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.

Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

Mass storage device (HDD)

Mass storage device (HDD), commonly referred to as a hard drive or hard disk, is 
a non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.
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IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.

IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.
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ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.

LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.
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MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.

NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.
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OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.

PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can be used 
in a printer, a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.
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PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.

SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.
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SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by by a 
combination of heat/pressure from the fuser, causing it to bind to the fibers in 
the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple 
Macintosh operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.



Glossary

259 Glossary

WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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